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Print Censor 4.5 Requirements and Recommendations

Software Requirements and Recommendations:
Print Censor service

Required for Install:
e Windows 2000/XP/2003

Print Censor client

Required for Install:
¢  Windows 2000/XP/2003

Hardware Requirements and Recommendations:
Print Censor service

Required for Install:
e 4MB free HD Space
Recommended:
e 256MB RAM
e 500MHz or above x86-compatibility computer

Print Censor client

Required for Install:
e 2MB free HD Space

Print Censor database

Recommended:
e 100MB or above free HD Space with disabled storing the content of print jobs
e 25GB or above free HD Space with enabled storing the content of print jobs
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Introduction

Print Censor is an easy-to-use program designed to record a printer's usage statistics and to simplify the
management of network printers. Using Print Censor only, you can save the print jobs content. With
Print Censor you can limit the number of pages a user can print by setting quotas for the number of pages
printed or for the print cost. After a user exceeds a specified quota, access to the printer is denied.

Print Censor gives you all necessary information about every print job:

user name;
computer name;

document name;

time & date of printing;

number of pages;

number of copies;

document size;

priority;

paper size;

color of printing (colored or black and white);
whether it was a duplex printing or not;

print job cost.

Using Print Censor you can:

Copy/move print jobs from printer to printer;

Preview contents of print job before sending to printer;

View the printed jobs content.

Notify users when quotas are exceeded;

Control all the printers simultaneously;

Sort printers by a desired parameter (e.g. when sorting by the number of jobs currently running,
you can see the most overloaded printers).

Print Censor can determine and store print jobs created under various operating systems: DOS, Windows
3.11/95/98/ME Windows NT/2000/XP, Windows Server 2003, Macintosh, Linux n gpyrux Bepcusix Unix.
Print Censor features an improved print jobs manager. All basic operations and print jobs can be handled
directly from Print Censor. The software also features remote management of printers installed on other
computers. You can also remotely install and configure Print Censor to store print jobs on remote
computers.

All the information can be collected for preview in any number of ways. Exporting the data into files of
various formats is also supported.

Print Censor works as service. This means it automatically starts when the computer boots up and all
print jobs will be recorded, even if a user does not log in to the system.

Thus, using Print Censor, you can make routine print job management easy, cut down your printing
expenses and better predict the need for printing materials for the whole network.
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Licensing

A license is granted for one computer. This means one license is needed to use the software on one
computer. You can use different types of licenses:

1. Single printer license;

2. 2-5 printers license;

3. 6-10 printers license;

4. Unlimited printers license.

Before installing Print Censor, let's look at a typical network configuration, and determine the computers
to which we should install Print Censor:
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Printer A and Printer C are connected to computers directly (using LPT or USB ports). Printer B is
connected to network using a TCP/IP netcard.

In this case, to control:

1. Printer A —install Print Censor on Computer 1;

2. Printer B — install Print Censor to a computer which will be a print server for all the other
computers in the network, and make Printer B shared for all the other users;

3. Printer C —install Print Censor on Computer 4.

In this case, one license “Single printer license” and one license “2-5 printers license” are needed if you
choose Computer 1 or Computer 4 as a print server for Printer B. 3 licenses “Single printer license” are
needed if you choose Computer 2o0r Computer 3 as a print server for the same printer.
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Printer D Computer 2 Computer 3 Computer 4 Printer E

Printer B, Printer D and Printer E are connected to computers directly (using LPT or USB ports).
Printer A and Printer C is connected to network using a TCP/IP netcard.

In this case, to control:

1. Printer A and/or Printer C — install Print Censor to a computer which will be a print server for all
the other computers in the network, and make this printers shared for all the other users;

2. Printer B — install Print Censor on Computer 1;

3. Printer D — install Print Censor on Computer 2;

4. Printer E — install Print Censor on Computer 4.

In this case, 2 licenses “Single printer license” and one license “2-5 printers license” are needed if you
choose Computer 1, Computer 2 or Computer 4 as a print server for Printer A and Printer C.
4 licenses “Single printer license” are needed if you choose Computer 3 as a print server for these
printers.
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Print Censor Installation

Please read this before installation

Print Censor is designed to control printers in a Microsoft Windows network. It is presumed that all the
print jobs are sent from workstations to a Windows server (or a workstation which serves as a print
server) and not directly from a workstation to network printers.

You will need administrator privileges to install Print Censor to a local workstation or print server.

Installing Print Censor

Print Censor consists of two components: client and server. You can install them both, or only a client for
remote management.

Before installing Print Censor, make sure you are installing the latest version of the software. You can
download the latest version here: http://usefulsoft.com. Run setup.exe and follow the instructions.

When installing Print Censor, you may have to reboot the computer if the files which should be replaced
are currently in use. After system reboot, all the necessary files are updated.

If the installation wizard did not ask for a system reboot, you can start using Print Censor immediately.
Server component

The Server component is the Print Censor, service which should be installed to a print server to allow the
following:

1. Print job recording.
2. Control of quotas.
3. User notification of quota status.

Client component

The Print Censor client component can be installed to any server or workstation and can remotely
manage any print server on which the Print Censor service is installed. Also you can control

Previous version update

You have to un-install previous version of Print Censor before installing a new version. If you want to
keep print job history, do not delete the old database when un-installing the software.

The new database format is incompatible with the Print Censor 3.x and 4.1x database format.
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Using Print Censor

Print jobs storing

By default Print Censor automatically stores the print jobs for all local printers which are installed. All print
jobs will be stored for all printers, which will be added after Print Censor installation. You can change this

mode by disabling the «Enable History» option in «Global Printer Options».

History of jobs is possible for local printers only, while network printers can work with print queue only.

Here you can also configure storing the content of print jobs for viewing. You can use this feature to view

printed jobs in the history log.

Print Censor Professional

File Edit Yiew Printer Options Help
&h Printers | @ Queus !ﬁ Users Reparts
Prinker History | Content Cost | Restrictions | Pause Jobs Prinker options
6 = Global Printer Options = es es $0.05  Yes Mo -~
6 AP Epson Stylus Photo 1200 es es $0.05  Yes Mo
6 AP HP Desklet 1220 es es $0.05  Yes Mo
6 AUP HP Laserlet 1100 Yes Yes $0.05 Yes Mo Printer options. ..
6 AUP Kerox DocuPrink PEex ‘fes ‘fes $0.05  Yes Mo .
Frinter Info
6 GEQL Canon MFS&00 ‘fes ‘fes $0.05  Yes Mo .
Location:
6 GEOL HP DeskJet 1220 es es $0.05  Yes Mo
Comment:
6 GSPP EPSON Stylus Photo 2100 es es $0.05  Yes Mo
6 G5PP HP LaserJet 1100 ‘fes ‘fes $0.05  Yes Mo
6 HP Color LaserJet 4500 es es $0.05  Yes Mo
6 HP Designlet 1055CM - 1 ‘fes ‘fes $0.05  Yes Mo
6 HP Designlet 1055CM - 2 ‘fes ‘fes $0.05  Yes Mo
6 HP Designlet 1055CM - 3 ‘fes ‘fes $0.05  Yes Mo
6 HP Designlet 5500 - 1 ‘fes ‘fes v Mo
6 HP Designlet 5500 - 2 Yes Yes v Mo
& HP LaserJet 5100 Yes Yes Printer options... Mo
6 HP Laserlet 8100 - 2 ‘fes ‘fes FoUa e Mo
A TEAN LN ek 1120 i i +0OE e R b

After you click the "Printer Options..." button, you can specify the advanced options of the selected printer

or of the global printer option:

Options
Pausing
Prinker Type
Cost

Restrictions

Printer, Options - HP DesignJet 1055CH - 4

Prinker Options
[Juse global printer options
Enable Print Jobs Hiskory

Save the content of print jobs For viewing

Print Jobs Content Storage Options

[Juse global storage options

Maximum skorage size: 100 ~ ME
‘Wwhen maximum storage size is reached:
() Overwrite records as needed

() Overwrite records older than

(%) To nok delete records

(Storage size will increase automatically)

X

Ok

J

Cancel
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You can use the "Options" tab to specify the main options
of the printer: keeping the history of print jobs, saving the
content of print jobs for viewing. You can also set some
additional options of print jobs content storage, such as
maximum size and actions performed when maximum
storage size is reached. When the storage reaches the
maximum size, you can overwrite records as needed,
overwrite records older than a certain number of days or
perform no actions at all (in this case the report size will
increase automatically). You can also use global options.

You can use the "Pausing" tab to specify the pausing
options of the print jobs. You can pause all new print jobs
and lock this print jobs. After that they can be restored
only from Print Censor, having pressed button "Restore"
with Ctrl button. You can set time of automatic restoring
of these print jobs. If you will select an option “Show the
status of paused print jobs in the print queue manager”
the status of these print jobs can be seen in standard
print queue manager. You can also use global pausing
options.

You can use the "Printer Type" tab to specify the printer
type options of the printer. Selecting the type of the
printer (standard or plotter) will be useful while estimating
the cost of print jobs. If you set it as a standard printer,
the cost will be estimated depending on the number of
pages in each print job, while for the plotter this cost will
be estimated depending on the length of each print job.

You can use the "Cost" tab to specify the cost options of
the printer. You can specify the cost of standard, black-
and-white and duplex-mode printing. You can also use
global cost options.

Prinker Options
[Juse global printer options
Enable Print Jobs Histary

Save the content of print jobs For viewing

Print Jobs Conbent Storage Options

[Juse global storage options

Maximum storage size: 100
‘When maximum storage size is reached:

() Overwrite records as needed

(O Overwrite records older than

(¥ To ot delete records
(Storage size will increase automatically)

Pausing Options

[Juse global pauising options

Pause all print jobs

Allov Eo resume print jobs From Print Censor only
Resume print jobs automatically after 10
[Iresume print jobs automatically at

Show the status of paused print job in the print queue manager

Prinker Type

(%) Standard printer
Tracking cost per page number

(O Plotker
Tracking cost per job length

Some new print drivers don't track color information correctly and if you are having

-~
»

ME

days

rinutes

any problems with the correct tracking of your print jobs please enable this option,

[ This is black and white printer

Cost Options

[use Global Cost Options

EBase cost: $0.05
Black and white: |- % [|20 %
Duplex mode: + |80 b 4
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You can use the "Restrictions" tab to specify restrictions
for the current printer. You can limit print jobs by the
number of pages in them, by their copies, size, priority,
cost, title, paper size and computer. You can also use
global restrictions.

Deny Prinking

[Juse Global Restrictions

[C11F document contain is over

If document contain is over

[C11F document: size is greater than

If document priority is greater than

[C11F document cost is greater than

If title contains one of the following strings

[C11F paper size contains one of the following strings

[C11F computer contains one of the Following strings

pages
~ )
% copies

KE

4

Customize. ..
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Viewing stored print jobs

To view all print jobs for all the selected printers, go to the "Reports" tab and choose the desired report
format. The following report formats are available: Printers/Users, Printers/Computers, Printers/Paper,

Users/Printers, Users/Computers,

Users/Paper,

Paper/Printer,

Computers/Users, Computers/Printers and Computer/Paper.

Print Censor Professional

Paper/User,

Paper/Computer,

File Edit Yiew Report

B4 @B &F e

Options  Help

CBX

& Printers @ Queus !ﬁ Users| Reports |

i Repart by Prinker/User v|Range: [7]] 3j 1yzo0s v |- [ 4f yjzoos v | >
Printer/ser Pa...  Jobs Cost Size: User Prinker Computer
B Al Print Jobs $115.13  15.61 GB ﬂ marita 6 AP Epson Stylus Photo 1200 g ig5-3.geciru A
@ AUP Epson Stylus Photo 1200 4 1 40,20 32,79 ME € roza G AUPHP Desklet 1220 =) ige.geciru
6 AUP HP Desklet 1220 116 gz $5.95  438.07 ME ﬂ roza 6 AP HP Desklet 1220 ig6.geoi.ru
@ AUP HP Laserdet 1100 392 92 $16.32 2745 MB & AlCD Dot oo ig6.gedi.ru
= (& GEOL HP DeskJet 1220 65 41 $3.40 1335 ME 0 oroza G Al Preview. = ig6. geoi.ru
€ ship 65 41 $3.40 1335 ME € oroza Gh Al € Exclude User =) ig6. geci.ru
@ GSPPEPSON StylusPhoto 2100 242 37 $12.10 507.01 MB € oroza Gh Al 8 Excluds Printer =) ig6. geci.ru
@ GSPP HP Laserdet 1100 14 4088 27091 ME € oroza Gh Al = E.clude Computer =) ig6. geci.ru
= (& HP Color LaserJet 4500 4 3@ 42,05 590,08 ME € oroza Gh Al =) ig6. geci.ru
ool 3z az $1.60 S87.82ME || €3 roza G Al Include Al =) ig6. geci.ru
€ kongm 5 z 40,25 1.57ME € roza G AUPHP Desklet 1220 =) ig6. geci.ru
€ oos z z 40,10 35,37 KE € roza G AUPHP Desklet 1220 =) ig6. geci.ru
ﬂ geofis 2 2 $0.10 664,52 KE ﬂ roza 6 AP HP Desklet 1220 g ig6.geoi.ru
6 HF Designlet 1055CM - 1 213 212 $10.65 5.47 GB ﬂ roza 6 AP HP Desklet 1220 g ig&,geai.ru
6 HF Designlet 1055CM - 2 252 180 $13.20 5.57 GB ﬂ roza 6 AP HP Desklet 1220 g ig&,geai.ru 3
@ HP Designlet 1055CHM - 4 70 54 §3.50 1.07 GB {‘ R e s
< > Detailed Chart

Then select "Report" -

"Generate Report". In the window opened, select the desired printers which have

recorded print jobs. If you do not see the desired printer in the printers list, this means there are no
recorded jobs for this printer (or you deactivated an automatic print jobs recording for this printer). On the
"Time period" tab, you can set the desired time period. You can set the time period manually or choose
from pre-set variants, such as "Current Month", "Current Week", "Today", "Last Month", "Last Week", or

"Yesterday".

Report options

Frinters | Date Range |

Chooze printers for which you want to generate the report
() For all printers
O Only for these printers:

0K

J

Cancel ]

Report options E]|E| rz|

Ot
O Curent Manth O Previous Month
O Curent Week (O Previous Week
O Today O Yesterday
(& Manually
[ Ok, ] [ Cancel

-10 -
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After choosing all desired parameters, click the "OK" button to generate a report. After the report is

generated, you can view detailed information about all the print jobs. Use the "Chart" mode to make the
information more visual.

Print Censor Professional

File Edit Yiew Report Options Help

B4 @ & @
& Printers @ Queus !ﬁ Users | Reports |

Range: 3 1fz006 v | - [B]| 4 1f2006 v &
B ~UF Epson Stylus Phato 1200 | OPfons
I AP HP Deskjet 1220 () Printed Jobs
= : 1 AUP HP Laser]et 1100 @ Printed Pages
_____ : B GEOL HF Deskjet 1220 )
3507 ! [ GSPP EPSON Stylus Photo 2100|  © Printed Cost
& [ G5PP HP Laseret 1100
00 : B HP Color Laser)et 4500 [¥] show Legend
ol g R B HP Designjet 1055CM - 1
B I T I T T e L Il HF Designet TO55CM - 2
2007 B HF Designlet 1055CM - 4
1507 | BEIN D [ HF Desigret 5500 - 1
S NI I HP Design]et 5500 - 2
1007 | ! B HP Laser]et 2100
ISl B | | B ERRi . - [ HP Laserjet 8100 - 2
30 G190 HP Laser]er 1160
Il (G5 HP DeskJer 1220

o | | | |
son Stylus Photo 1200 HF Laser|et 8100 B 155 HP DeskJet 1120

I 158 Epson Stylus Photo 1200
[ CBR HP Laserjet 1100

Detaled ¢ Chart

-11 -
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Printing a report

You can print your report after viewing. To do this, select the “File’->"Print” menu item. You will find the
report preview in the window; you can also choose additional print parameters such as printing the report
caption, column headers and page numbers. You can also delete some pages of your report here,
change paper orientation and margins.

You can also export data into one of the following data types: text file, HTML file, XML data, Excel file,
RTF file, BMP image, JPEG image, TIFF image, and PDF file.

Report Preview

Report Type

O Total

() Detailed
Chart

Fieport Options
Fieport Caption

Frint Cenzor report

Colurmn Header
FPage Mumbers

[Margins... [ Delete ]

Export Ta

v[ Export... ]

Text [matrix printer]
THL file

Excel table [*kL)
Excel table [OLE

BMF image...
JPEG image...
TIFF image...
e D1 daane o Titam e M POF file...
le | < Page 1 of 2 Frint...

-12 -
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Quotas

You can specify global quota options and quotas for separate users on the "Users" tab.

Here you can view user’s quotas; reset the balance of the selected users, remove users you do not need
and specify advanced quotas and restrictions options.

Print Censor Professional |._||E|r5__<|
File Edit Yiew Account Options Help
@ Printers @ QueLe !ﬁ Users Reparts
User Balance Quota | Restrinctions | Pause Jobs | Updating | Date of up... User options
€ = clobal User Options = Unlimited Mo Mo Mo ”~
— Reset user balance
€ e 46 Unlimited Mo Mo Mo
€ ol 25 Unlimited Mo Mo Mo
€ alina 43 Unlimited Mo Ha Ha
T T
€ bank 72 1j  Resetuserbalance Ho
€ el o Add users Ha
€ feol g1 1 Mo B
it 125 U X Delete user Ho
€ a4 User options. .. Ha
€ gl 3 Unimited Mo 0] Mo
€ garna 39 Unlimited Mo Mo Mo
€ gecfis 66 Unlimited Mo Mo Mo
ol 18  Unlimited Mo Mo Mo
€ quia 113 Unlimited Mo Mo Mo
€ guinor 2 Unlimited Mo Mo Mo
€ ilmiral 11 Unlimited  Ma Ha Ha
€ ina 32 Unlimited Mo Ha Ha
"= - £%  Ulelimmibad Rl Rin Rin b

IReset user balance

After you click the "User Options..." button, you can specify the advanced options of the selected user or
of the global user options:

Account Options rz|
Account Options
Pausing [Juse Defaulk Account Options
Restrictions

(O Unlimited Printing
() Limit by Account Balance: 200

Mote: When account balance reached this restriction, printing will be denied.

Account Updating
[use Default Account Updatign

Action: |Reset Account Balance e

‘When to update: |Week|y w ||On the 1st day A

Tirne: of day: 12:00:00 &M 5

Ok, ] [ Cancel

-13-
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You can use the "Account" tab to specify quotas for the = A=omerne
selected user. You can set printing as unlimited or specify [0 Defauk Account Options
a limit depending either on the cost of printing or on the =~ ©trimitsdFrinting
number of printed pages (depending on the current quota by Account Bslance:
Settings). Here yOU can also Specify Options f0r Updating Mote: When account balance reached this restriction, printing will be denied.
the balance of the selected user. You can set the balance  account updating

to be reset either at the specified intervals or at a  [Juseoefault account Updation

200

particular t|me Action: Reset Account Balance -
When to update: | Weekly + || On the 1st day A
Tirne: of day: 12:00:00 &M 5

You can use the "Pausing" tab to set the pausing options " oeters

for the selected user in the same way as for printers. [use dobal pavising options
Pause all print jobs
Allov Eo resume print jobs From Print Censor only
Resume print jobs automatically after 3] 2 minutes

o

[Iresume print jobs automatically at

You can use the "Restrictions" tab to set the limits of ™™™
printing for the selected user in the same way as for U GebslRestrictions

i If document contain is over pages
printers. U
If document contain is over 10 : Copies
[C11F document: size is greater than KE

[C11F document priority is greater than
[C11F document cost is greater than
[ 1F title contains one of the following strings

[C11F paper size contains one of the following strings

If computer contains one of the Following strings

-14 -
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Print Queue

Print Censor allows you to view the print queue for any printer in your network. Moreover, unlike the usual
Windows print queue window, Print Censor allows you to control all the printers simultaneously.

Working with printers

Print Censor features all the standard operations. To perform them, all you need is to right-click the
desired printer and select an action:

e «Open queue...» - open Windows print queue view window (you can also simply double-click the
selected printer);

«Printer Web Page...»

«Set as Defaulty;

«Pause printing»;

«Cancel all Documentsy;

«Delete printer»;

«Properties...» - open standard printer properties window.

Working with print jobs

To make working with print jobs even handier, you can hide the printer’'s list panel. To do this, go to
"View" - "Show Printers/Servers Panel".

Unlike the usual Windows print jobs view window, Print Censor provides you with much more information
about print jobs. The following information is available:

e The name of the user which sent the job;

e The computer from which the job was sent. You can also see the DNS name of the computer
instead of its IP address. To enable this feature go to "Options" - "Preferences...", on the "Global"
folder and select "Resolve IP addresses";

e Job status;

e Document name;

Number of pages. Here you can see an approximate number of pages even for those print jobs

which you normally cannot see in Windows printing queue view window;

Number of copies;

Job size;

Job creation time and date;

Paper size;

Priority;

Color mode (colored or black and white);

Duplex mode (double-side printing);

Print job data type;

Position in a queue;

Print job ID.

You can also hide unnecessary columns. To do this, simply right-click on the columns header and select
the desired columns.

The following status operations are available in the print queue window:

Pause job;

Resume job;

Restart job;

Preview job;

Move/Copy job to another printer;
Cancel job;

Change all standard job parameters.

-15-
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File Edit Yiew Printer Job  Options Help
24 ¢ B $ O
@ Printers | @ Queue !ﬁ Users Reports
Printer Skatus Jobs 4 WPSYHP Designlet 1055CM - 3 - Paused PLx <)
6 AUP Xerax DocuPrint Paex Ready 0 User Computer Docurnent Status Pages = Copies <
6 GECL Canon MFS600 Ready 1] ¥ aroat =Y alex.g...  kapra_l.cdr Paused 1 1 i
6 GEOL HP DeskJet 1220 Ready i} € aroot g alex.g...  ¥_nagr.cdr Paused 1 1 1
6 GSPP EPSON Stylus Photo 2100 Ready 1] ﬂ arook g alex.g... bobr_d4v_n.cdr Paused 1 2z 33
6 GSPP HP LaserJet 1100 Ready i} € aroot g alex.g...  B_nagr.cdr Paused 1 1
6 HP Color LaserJet 4500 Ready i} € aroot g alex.g...  B_nagr.cdr Paused 1 1
6 HP Designlet 1055CM - 1 Ready 1] ﬂ arook g alex.g...  Y_nagr.cdr Paused 1 1
6 HP Designlet 1055CH - 2 Ready 1] # kondr 1 1
Paused ﬂ kondr g serge. | Paused 1 1
6 HF Designlet 1055CM - 4 Ready i] € kondr g serge. | O Paused 1 1
6 HF Designlet 5500 - 1 Ready i] € kondr g serge. | © Restart Paused 1 1
6 HF Designlet 5500 - 2 Ready i] € kondr g serge. | Preview. .. Paused 1 1
6 HP LaserJet 100 Ready i} € aroota g alex.a. Paused i} 1
6 HF LaserJet 5100 - 2 Ready i] € kondr g serge. | Copy Ta... Y | Paused 1 1 7
& 1G10 HP LaserJet 1160 Ready i € kondr =) serge,  MoveTo.. Y | Paused 1 1 1
& 1G5 HP Desklet 1220 Ready i € oaroot B sl ogecral s | Paused 16 2
& 1GE HP Desklet 1120 Ready i € oot =) alexg. Paused 24 3
i T8 Frean Shlie Dhaka 1200 Ciaac n ™ @ aennk (] slev | ¥ Cancel Del Panzed 14 7 o
< ¥ ¥
Properties...

For each print job you can now view and change all default parameters, and you can do it for several
printers at the same time.

Print Job Preview

=] % Page (1 |of1 }9 ﬁ‘) Page “Width v

o Windows
windows  Printer Test Page

Congratulations!

f you can read this information, you have correctly installed your W
Designlet 105504 by HF on FS.

The information below describes your printer driver ard port settinas.
Subi thed Time: 3 21 51 PM 3/9/2006

Friner names WP Designdet 105504 - 3

Printer model: HP Designlet 105504 by HF

Color support:
Port nameCs): hnl055 -3

Data format: HT EMF 1.00&

share rame: HF Designlet 10554 - 5
Location

Cament:

DFiver hame: hpl tdrd 411

Help file: HFBLETLE . HLF

Driver wersion: 4.103

Erwiroment: Wirdows HT w56

additional files wed by this dr

= \wINDDWS\systené2\5mo1\D&IUERS\w32><86\3\hD'I i d11 Cv4 &7
CAWIHDOWS", 305 Tend 2% 2 ool DRIVE RSHWS 086, 3 hel tumpd . d Cwd BT w
CHUWTHOOWS Y 292 Tend 2 5 0001 L DRI VERS W03 Z¢6" Ty HFGLRTLS . H_P

You can preview print jobs in the queue. This will help you detect those print jobs that you do not need
and you will be able to save consumables and paper thanks to this feature.

Print job preview is available only for those printers that have printing in the EMF format enabled for them.
To enable this mode, open the Properties dialog box for the printer you need and switch to the
"Advanced" tab. Select the "Enable advanced printing features" checkbox at the bottom of this tab. Then
click the "Print Processor" button, set the print processor to WinPrint and the default data type to "NT
EMF 1.008".

Now you can preview print jobs sent to this printer.

Note: some printer drivers do not support EMF printing. It is impossible to preview print jobs for these
printers.

You can also copy or move jobs from one printer to another. It can be useful in many cases, for example
you can copy a job to print it several times, and moving a job will help you when there’s no more toner in
one of the printers, and you may move the jobs to another printer that is free at the moment.

Note: you can copy and move print jobs only between computers running under Windows
NT/2000/XP/2003. EMF printing must be enabled for the source printer. Thus, if you can preview a print
job, you can also copy or move it.
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Network Printers

To view the print queue of the network printers, go to the "Options" menu and select "Show Network
Printers"

If you need to work with the print jobs queue for an extended time, you can choose the "Queue Manager"
mode. To start working in this mode, select "Queue manager only" in the "Options" menu.
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Customizing Print Censor preferences

Choose the “Settings”->"Preferences” menu item to customize Print Censor preferences.

Preferences g|
& Language
= ﬂ Quotas English + | Download
[ Pages
[ Copies Options
% ;D_b stlze [ always show in the System Tray
tiotity

@ Cost |:| Minirnize ko Syskem Tray
[ Job Title
[ Paper Size Resolve IP addresses
[ Computer {11173.50,210.75 - = alex.prog.com )
[ Balance
@ Usernarne Save window position

Reparts

E_'g Computers
a"-', Lockout

Ok, ] [ Cancel

On the “Global” tab you can set the program interface  “™“*

language (additional languages can be downloaded from = 5| Dovnioad
Print Censor site at http://usefulsoft.com/download or by  optins

clicking the “Download” link). The options for working with ~ Claways showin the System Tray

a system tray are: Minimize Print Censor to System Tray  [J#inmie to System Tray

and Always Show Print Censor in the System Tray. YOU  Flresohe Ir sddresses

can also set the option of displaying DNS names of (11173.50,210,75 -3 sl prog.com )

computers instead of their IP addresses.

Save window position

You can use the "Quotas" page specify quota options. =%
You can set quotas either by the number of printed pages 8232:: :z: :g: EZ:t”t
or by the cost of printing.

Choose this option if you need ko set quotas on number of the printed pages.
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You can use the “Pages” page to specify what the server
should do if the number of pages in a print job exceeds
the restrictions for printer or user. Here you can choose if
such print jobs should be paused or removed from the
queue. Also you can specify a message to the user who
sent such a print job telling him that his print job is either
paused or deleted.

You can use the “Copies” page to specify what the server
should do if the number of copies in a print job exceeds
the restrictions for printer or user. Here you can choose if
such print jobs should be paused or removed from the
queue. Also you can specify a message to the user who
sent such a print job telling him that his print job is either
paused or deleted.

You can use the “Job Size” page to specify what the
server should do if the size of a print job exceeds the
restrictions for printer or user. Here you can choose if
such print jobs should be paused or removed from the
queue. Also you can specify a message to the user who
sent such a print job telling him that his print job is either
paused or deleted.

You can use the “Priority” page to specify what the server
should do if the priority of a print job exceeds the
restrictions for printer or user. Here you can choose if
such print jobs should be paused or removed from the
queue. Also you can specify a message to the user who
sent such a print job telling him that his print job is either
paused or deleted.

Page Counkt opkions

‘When the user attempts to print a file which exceeds the maximum number of
pages:

(%) Pause the print job
() Delete the print job

[5end pop-up message to the user

This job exceeds the maximum allowable page count For a single job. Print
Job Cancelled, Please contact your administrator,

Copies opkions
‘When the user attempts to print a file which exceeds the maximum number of
Copies:

(%) Pause the print job
() Delete the print job

[5end pop-up message to the user

This job exceeds the maximum allowable copies for a single job. Print Job
Cancelled, Please contact your administrator,

Job Size options
‘When the user attempts to print a file which exceeds the maximum size:

(%) Pause the print job
() Delete the print job

[5end pop-up message to the user

This job exceeds file size limit, Print Job Cancelled, Please contact your
administrator.

Priority options
‘When the user attempts to print a file which exceeds the maximum priority:

(%) Pause the print job
() Delete the print job

Send pop-up message ko the user

This job exceeds the maximum allowable priority, Print Job Cancelled, Please
contact your administrator,
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You can use the “Cost” page to specify what the server
should do if the cost of a print job exceeds the restrictions
for printer or user. Here you can choose if such print jobs
should be paused or removed from the queue. Also you
can specify a message to the user who sent such a print
job telling him that his print job is either paused or
deleted.

You can use the “Job Title” page to specify what the
server should do if the title of a print job does not fit within
the restrictions for printer or user. Here you can choose if
such print jobs should be paused or removed from the
queue. Also you can specify a message to the user who
sent such a print job telling him that his print job is either
paused or deleted.

You can use the “Paper Size” page to specify what the
server should do if the paper size of a print job does not
fit within the restrictions for printer or user. Here you can
choose if such print jobs should be paused or removed
from the queue. Also you can specify a message to the
user who sent such a print job telling him that his print job
is either paused or deleted.

You can use the “Computer” page to specify what the
server should do if the computer of a print job does not fit
within the restrictions for printer or user. Here you can
choose if such print jobs should be paused or removed
from the queue. Also you can specify a message to the
user who sent such a print job telling him that his print job
is either paused or deleted.

Cosk options
‘When the user attempts ko print a file which exceeds the maximum cost:

(%) Pause the print job
() Delete the print job

[5end pop-up message to the user

This job exceeds the maximum allowable cost, Print Job Cancelled, Please
contact your administrator,

Job Title options
‘When the user attempts ko print a file which has been restricted by title:

(%) Pause the print job
() Delete the print job

[5end pop-up message to the user

Printing documents with this title is not allowed, Print Job Cancelled, Please
contact your administrator,

Paper Size options
‘When the user attempts to print a file which has been restricted by paper size:

(%) Pause the print job
() Delete the print job

[5end pop-up message to the user

Printing documents with this paper size is not allowed, Print Job Cancelled.
Please contact your administrator,

Computer options
‘When the user attempts to print a file which has been restricted by paper size:

(%) Pause the print job
() Delete the print job

[5end pop-up message to the user

Printing documents From this computer is not allowed, Print Job Cancelled,
Please contact your administrator,
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You can use the "Balance" page to specify what the
server should do a print job exceeds the balance of the
user who sent it. Here you can choose if such print jobs
should be paused or removed from the queue. Also you
can specify a message to the user who sent such a print
job telling him that his print job is either paused or
deleted.

You can use the “Username” page to specify what the
server should do if the name of the user who sent a print
job is absent in the database of the program. Here you
can choose if such print jobs should be paused or
removed from the queue. You can allow such print jobs to
be printed. In this case the new user will be added to the
database of the program and the default quotas will be
applied to him. Also you can specify a message to the
user who sent such a print job telling him that his print job
is either paused or deleted.

On the “Report” tab you can customize the parameters of
working with your report file. It is possible to change its
path if there isn’t enough space on the default drive. You
can also set some additional options of report file
processing, such as maximum size and actions
performed when maximum report size is reached. When
the report reaches the maximum size, you can overwrite
records as needed, overwrite records older than a certain
number of days or perform no actions at all (in this case
the report size will increase automatically).

You can use the "Computers" page to specify the drop-
down list of computers for connecting to other computers.
Here you can add new computers, remove those you do
not need and change their order.

Balance options

‘When the Balance {pages or money) in the users Account is exceeded:

(%) Pause the print job
(O Delete the print job

[5end pop-up message to the user

Insufficient balance in account For this job, Print Job Cancelled, Please

contact your administrator,

Username options

‘Wwhen a print job is submitted with no username, or an unknown usename:

(O Pause the print job
(O Delete the print job
(®) allow the job to print

[5end pop-up message to the user

‘fou are not authorized to print on this prinker, Print Job Cancelled, Please

contact your administrator,

Reports Path

Use default reports path

Reports size

Maximum reports size: 10
‘When maximum reports size is reached:

(O Overwrite records as nesded

() Overwrite records older than

(¥ To ot delete records
(Report size will increase automatically)

Computer lisk For remote connecting
Alex

PS5

Wark

days

Up
Daown
Sart

Delete
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On the “Lockout” tab you can enable the option of locking k”“t opriens
e . . . . v i

any m0d|f|Cat|0nS Of Prlnt Censor 0pt|0nS. YOU can: IOCk Select the actions to lock, then enter a password in both fields, Users must provide

Changing the Jobs History option for printers, lock this password when performing an action that is locked here,

changing the quotas and lock changing the report file

options. After you enable the lockout, you'll have to enter ~ [Jedt Printers settings

password to modify the locked options. iy vzem e
[JEdit Quotas settings

Edit Reports settings

Password: bk

Confirm password: ko

On every Print Censor tab you can arrange the data by any column, and hide unneeded columns by right-
clicking the column header and selecting the “Select Columns...” menu item.

Select Columns §|

Calumnns:

v User

| Printer

| Computer
| Document
v| Pages

v| Copies

v| Size

| Printed

| Submitted
| Priority

v| Paper Size
| Calor

v| Duplex
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